Welcome to the Productivity Suite Programming Software 2.4 Release Notes

This document describes some of what's new in this release of the Productivity Suite Programming Software. It also
includes updated information for the documentation provided with this software. The information in this file and in the
Help system is more up-to-date than that in the manual.
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Part 1: Welcome

AutomationDirect.com would thank you for using the Productivity Suite Programming Software. We have loaded many
powerful and exciting features to the New Productivity Suite software; however we know that our customers sometimes
have great ideas for features. Please feel free to give us input on the Productivity3000 product line and you may even

request features that you feel would add more value to the software for your application.

http://support.automationdirect.com/techcontact.html

Part 2: Getting Started

You can find "Getting started with Productivity Suite" information in the Productivity Suite help file by selecting the
Getting Started topic in the Software Help file.

Part 3: What's New?
Please note that the entries in this section have been rotated to read information relevant to the current version first.

Productivity Suite Release Notes
Version 2.4.0.16
Release Date: 12/07/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Improvements:

1.) New Productivity Network (ProNET) feature adds the ability to share data with other P Series CPU's easily by using
the Productivity Network (PNET) setup in the hardware configuration window that is used to join a data sharing
network that consists of other P-Series Controllers.

2.) New Custom Protocol over Ethernet (CPoE) feature allows the ability to Send or receive structured Hex Based data
to/from another device over Ethernet in situations where the CPU must communicate to another device that has Hex
Based communications.

3.) Added Check marks to indicate each step is complete in Firmware upgrade window.
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4.) Added the ability to Show control characters, Show string values in hex (separated by spaces), Show string values
in decimal (separated by spaces) for

String tags in Data View.

5.) Bit of Word elements can now be viewed in Dataview by right clicking on a word and selecting "show bit of word
details".

Bug fixes:

1.) EtherNet/IP Client Properties: Everywhere it says "Connection Point" added "Assembly Instance".

2.) Removed ability to clear MST bits through Data View.

3.) Unable to Import 2D arrays if the Array exists in the Tag DB.

4.) Data view |10 View doesn't show actual module slot.

5.) Pressing Space no longer opens Module Property Page in Hardware Configuration.

6.) BOW for 2D array data type’s exports too many BOW elements.

7.) EMSG instruction Connected message is setting error bit status. The status bits for the connected messages don't
apply to connected messages.

8.) Auto assign or clear all Modbus address, Remote Access and Retentive in Structures does not work

9.) TagDB, Initial Values, click-away should save edits.

Productivity Suite Release Notes
Version 2.3.0.14
Release Date: 11/02/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Improvements:

1.) New Instruction Return from Called Task (RFCT) used to Stop and immediately Exit from a Called Task
2.) Added support for new P2000 modules: P2-04DAL-1, P2-04DAL-2, P2-08NAS, P2-08TAS, P2-08TD1S, P2-08TD2S, P2-
15TD1, P2-15TD2, P2-32ND3, P2-32TD1P, P2-32TD2P.

Bug fixes:

1.) If Sequence (SEQ) instruction is in a called task & the initial step is set to a disable step, the CPU will have an E01005
critical error.

2.) Error "The project's files could not be generated" is displayed when transferring the attached project.

3.) Customer Project causes the GUI to Hang during Transfer to CPU due to an incomplete rung.

4.) Unable to open P2 Module Property Page after module was moved in the base.

5.) Cannot Minimize Window to do project convert on smaller resolution.

6.) P2-550 Property Panel highlights for the Transfer to/from SD Card in hardware configuration page in the wrong area.
7.) Pack Word (PKW) instruction incorrectly converting from Integer 8 Bit Unsigned to Integer 16 Bit data type.
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Productivity Suite Release Notes
Version 2.2.3.1
Release Date: 8/30/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.
Bug fixes:
1.) Initial value may not be updated on retentive marked tags during a stop mode transfer.
Productivity Suite Release Notes
Version 2.2.2.1
Release Date: 8/3/2016
IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.
Bug fixes:
1.) Removed the 250 msec. & 125 msec. digital filter settings in the hardware configuration for the P2-08NTC

module since these settings will cause the module to become unresponsive after run or stop mode project
transfer.

Productivity Suite Release Notes
Version 2.2.1.1
Release Date: 5/19/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) Ladder view issue when using a Boolean array on a contact with an integer tag as the index.

2.) Find/Replace no longer works with Bit-of-Word tags.

3.) Third party import using Click 2.0 or higher software causes import failure.
4.) On occasion the Compile Error displays incorrectly.
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Productivity Suite Release Notes
Version 2.2.0.12
Release Date: 4/6/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Improvements:

1.) Start menu structure change for Windows 10 support.
2.) Added option to P3-550 to select a revision for correct retentive memory off line programming support.
3.) Added right click option to enable comments for bit of word and array tags in the TagDB.
4.) Third Party import allowing Nicknames to be imported from Click & DirectSoft projects.
5.) Check box added in the 'transfer project to removable media' dialog to include project source.
6.) Support added for new modules:
a.) P2-RS
b.) P2-08NTC
c.) P3-550E
Note: You must use firmware 1.2.2.x or higher for new module support. Using an older version may cause
unexpected results.

Bug fixes:

1.) CSV Import does not enforce disallowed characters

2.) Import tags not working after an “undo”

3.) Ability to create tags with invalid characters in an instruction

4.) When upgrading base firmware base is not being auto selected

5.) 2D array sizing rules not being enforced on CSV import

6.) Reserved Windows characters used in task names no longer breaks GUI ladder view.

7.) Ability to display left power rail when scrolling to left using arrow keys.

8.) Project Transfer not allowed if data logger has a non-existent tag name in Event Bit Tag name

Productivity Suite Release Notes
Version 2.1.3.2
Release Date: 2/29/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:
1.) Task names containing a Windows reserved character or name will cause ladder to be lost for that task or increased
project save times. Note: Any project created or saved in version 2.1.3.x can't be opened in earlier versions of 2.1.x.x.

Making backup copies of earlier version of projects is highly recommended.

2.) Array Statistics (STA) instruction displays the wrong function in the ladder editor when "MIN" or "MAX" are chosen.
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Productivity Suite Release Notes
Version 2.1.2.1
Release Date: 2/2/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) After a stop mode transfer using EtherNet/IP /O messaging, the first output write contains previous values in
registers for one RPI interval.

Productivity Suite Release Notes
Version 2.1.1.1
Release Date: 1/14/2016

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) Editing "Show" Outputs in SEQ instruction while using structures returns an error.

2.) Edit -> Undo after adding a step to the SEQ instruction will cause the Outputs to be incorrect.

3.) EtherNet/IP warning message references P3 when using a P2.

4.) PAC In Run bit can be copied and pasted from an older project.

5.) Sub rung entered incorrectly causes the Project File Status and the CPU project status not to synch up.
6.) PLS Instruction, Zero Reg. Checkbox moves when clicking the object.

7.) Project file status marked as "not saved" unnecessarily when a structure is enabled in an instruction.

Productivity Suite Release Notes
Version 2.1.0.16
Release Date: 12/16/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Improvements:

1.) Copy binary option added to Copy Array (CPA) instruction that copies the bit pattern, ignoring the numeric value it
represents.

2.) New Programmable Limit Switch (PLS) instruction added for Px-HSI module that is used to switch discrete outputs ON
or OFF based on the position of an encoder's rotating shaft.

3.) New Preset Table (PST) instruction added for Px-HSI module works differently from the PLS instruction and is more
similar to a Drum instruction.
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4.) Color Filled instruction blocks that allows a user the ability to enable, disable, or change the color for that group of
instruction blocks in ladder.
5.) Added structure support for EtherNet/IP Scanner devices.
6.) Copy and paste of GS drives & EtherNet/IP devices in Hardware Configuration window.
7.) Currently connected CPU now shows up as red text in CPU connections window.
8.) Support added for 12 new P2 discrete & analog modules.
9.) Six new Pack/Unpack instructions added to allow greater flexibility of data handling.
a.) Pack Word (PKW)
b.) Unpack Word (UPKW)
c.) Pack Word Array (PWA)
d.) Unpack Word Array (UPWA)
e.) Pack Boolean Array (PBA)
f.) Unpack Boolean Array (UPBA)
10.) Ability to turn structures off in Project Properties if no Structures are in the project.

Bug fixes:

1.) Null Pointer exception when changing PAC IP Address for a User Defined PAC.

2.) Cannot compile existing project that has more than 102K retentive tags if offline.
3.) Not all Comments are being imported.

4.) EtherNeT/IP Scanner Tags are not being marked as In Use.

5.) Deleting a row in SEQ instruction with blank show data breaks find/replace.

6.) Removed DataWorx P3K option from the 2.1.x.x installer due to obsolete.
7.) When creating a structure in an instruction the software allows Number constants.

Productivity Suite Release Notes
Version 2.0.5.6
Release Date: 11/3/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) Fixed issue which allowed a structure to be named the same as another tag. This issue made ladder disappear in the
GUI when an element of the structure was used.

2.) When default tags are removed from any module, odd behavior when adding back default tags.

3.) Constants are not allowed for the structure name when creating a structure in an instruction.

4.) Structure tags on occasion may not be added to the TagDB when created.

5.) Px-550 GSR (GS Drive Read) incorrect values may go into tags when toggling the manual read rapidly.

Note: Please review Errata from link on software download page concerning changes to GSR instruction.

Page 6 of 22



Welcome to the Productivity Suite Programming Software 2.4 Release Notes
Productivity Suite Release Notes

Version 2.0.4.1

Release Date: 9/18/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) Fix issue with tag values and constants being changed on a run time transfer.
Productivity Suite Release Notes

Version 2.0.3.1

Release Date: 9/1/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) Tag memory addresses do not hold on a run time transfer after addition or deletion of a tag thus causing possible
incorrect data for those addresses.

2.) Saving or loading of a project file can become corrupted when control characters are imbedded into a string tag.

Productivity Suite Release Notes
Version 2.0.2.1
Release Date: 7/30/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:

1.) Deleting or modifying the order of a row in the SEQ instruction that has a blank “show data table” will cause the
find/replace feature to not execute properly.

2.) Cannot import the TagDB containing comments that include the "=" sign.
Productivity Suite Release Notes

Version 2.0.1.3

Release Date: 6/22/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug fixes:
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1.) Not all comments are being imported after import of tag database .csv file.

2.) EtherNet/IP Scanner/Client tags are not being marked as in use in the tag database.

3.) Set retentive-tag limit to 491,520 in GUI to match hardware specifications.

4.) EtherNet/IP Unconnected Messages through the Internet may cause a CPU E01005 reboot.

5.) When deleting EtherNet/IP Scanner/Client tags from tag database would cause error on project save.

Productivity Suite Release Notes
Version 2.0.0.44
Release Date: 4/22/2015

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Improvements:

1.) Made ladder components less pixelated when zoomed.

2.) Compare project allows users to select P-Series project files (.adpro) and perform project-to-project comparisons on
these files. In addition, the Compare Project Tool provides you with a graphical representation of your ladder logic and
the ability to apply filters to perform a selective Compare. Once the Compare Project Tool has performed the
comparison, it generates a report detailing the differences between the two project files.

3.) Increased run time limit to 5000 tags for all data types except Strings 50,000 characters, 5,000 structure elements.
4.) Ability to easily convert a P3000 to P2000 or P2000 to P3000 project using integrated conversion utility.

5.) Added ability to insert or delete a step and modify order of a step in a Drum (DRM) & Sequencer (SEQ) instructions.
6.) Added support for the new P2-550 module and all supporting I/0 including (Analog, Discrete, High Speed,
Communications).

7.) Ability to force a contact or coil (if force is enabled) directly from ladder, including 'forced' icon ladder components.
8.) Built in print to .pdf option added for printing both ladder and compare project features.

9.) Removed right click options from Hardware Configuration and replaced with easy to find toolbar icons.

10.) Most recent projects added to software startup screen.

11.) New I/O View feature that allows a quick and easy way to monitor all hardware points installed in a system. A user
can also force on or off any discrete or analog point using I/0O view.

12.) Updated instructions panel to have collapsible categories, including a new favorite’s category that allows a user to
quickly add their favorite instructions to this area for quicker access.

13.) Added the ability to rename a task to the right click menu.

14.) Updated the Instruction shortcut feature with a new look, and added FLS, DBN, & TMC instructions.

15.) Changed to now have Monitor Mode icon description on at all times.

16.) Ability to now select rung(s) in ladder, and right click to send directly to print.

17.) Added ability to Print, Save, & Copy the DataView Graphing window with the right click option.

18.) Allow drag and drop or right click option of tags from DataView tabs directly into graphing window.

19.) Ability to drag already placed instructions in ladder and drop them into to another location in the same ladder
window. In addition, by holding Ctrl + Left mouse click you can copy that same instruction to a new location.

20.) You can directly access the tag search feature of find/replace via DataView, TagDB, or ladder editor by right clicking
on a tag, and selecting 'Tag Search for 'tag name'.
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21.) Enhancement to Print function to allow turning off of block details on all block instructions thus compressing down
the amount of printable pages.

Bug fixes:

1.) Monitor mode was not updating on large projects until user clicked inside the task.
2.) DataView Graph does not continue updates of tags on "other" tabs.

3.) Project status changes to save after system report is created.

4.) 1.3.x projects cannot be opened with 1.10.x and newer GUIs.

5.) Reboot of an RX/RS while in service mode cause GUI error/warning.

6.) P3 base disappears after docking into available part of GUI.

7.) Sometimes you are not able to delete Extra Tabs in DataView.

Productivity Suite Release Notes
Version 1.10.2.2
Release Date: 1/15/2014

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1.) EtherNet IP Connection Point (I/O messaging) parameter value and (Explicit Messaging) Service ID, Class ID,
Attribute ID and Instance ID ranges increased to 65535.
2.) When using brackets'[' & ']" in Find/Replace Comment search it causes invalid results to be reported.

Productivity Suite Release Notes
Version 1.10.1.1
Release Date: 9/29/2014

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1.) Moving tasks in a project with an LCD instruction may cause error at compile.

2.) Data Logger duplicated timestamp description removed from schedule interval option.

3.) H/W Config, "LCD Name", when renamed, both the default name and new name are available in LCD instruction.
4.) An INC/DEC instruction may not execute when it should when referencing Boolean array indexes.

5.) P3-SCM module(s) status information may become corrupted if it resides in between 10 module(s) which contain
MST information.

6.) New Instruction short feature main pop up window has misspelling.

7.) EMSG with whitespace in device name fails to compile.
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Productivity Suite Release Notes
Version 1.10.0.10
Release Date: 8/13/2014

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1.) With RX/RS in 'service mode' does not allow the IP address to be changed

2.) When you try to open links in help file PO06 for Agency Compliance and Certifications the software crashes.

3.) When you create a RX network read instruction and load to a PAC then go online and view the instruction in the GUI
monitor mode the tags in the RX instruction are garbled.

4.) Click for insert row in Data View, the popup window has the "before selected" option in focus. Hitting the "enter" key
does nothing.

5.) Cannot double click on an array tag in the data view window to edit the tag (like single element tag).

6.) Printing from Print preview screen missing pages.

7.) Memory Usage Calculation freezes up GUI with large project file.

8.) Export to KepDirect not working correctly due to added columns of new features.

9.) Clicking Send Edits will send the highlighted parts of "closed" Arrays".

10.) Some instructions are too large for small (low resolution) screens this affects MRX, MWX, RX, WX, VMW, and DRUM
instructions.

11.) Project could not compile until SUM Instruction was deleted and re-added.

12.) The "Radian" radio button does not work in the "MATH" instruction.

13.) Copy Array CPA not working correctly when the dimension of an array tag is changed while monitoring.

14.) Find/Replace is case sensitive cause data view window to not behave correctly.

15.) Deleting Rows in Data View reduced the number of Rows available.

16.) Monitor in Data view dialog box will not close when you try to append 64 bit module points to existing Data View 1
tab.

17.) Ramp Generator Instruction does not work properly when using Float Data Types for Max and Min Output.

18.) Issue with NC contact while using multidimensional array with a tag as an array index.

19.) Intermittently other than default colors are shown on I/O Overview panel only.

Improvements:

1.) New Feature: Tag I/O Reassignment allows a user to create tag(s), at will, without knowing what initial or final 1/0
modules will be installed in the system. With Tag I/O Reassignment a user can create tags, then later reassign these tags
to I/0O points once the module configuration is setup in the Hardware Configuration.

2.) New Feature: Structure data types are specific sets of tags combined together for convenience. Using Structures in
instructions can speed up overall programming because multiple tags are created and assigned automatically. A PAC
controller contains a set of predefined structures (data types) for use with all instructions such as timers, counters, etc.
3.) Default I/0 tags: With this option selected, when modules are added to the system their default 1/O tags are
automatically assigned to each 1/0 point. With the option deselected, when modules are added, none of the default I/O
tags are assigned to the 1/0O points.

4.) New Feature (P3-550 Only): Ethernet IP supports two types of messaging supported with the Productivity3000
EtherNet/IP protocol are 10 Messaging and Explicit Messaging. 10 Messaging is accomplished through a Class 1
Connection and Explicit Messaging can be accomplished through a Class 3 Connection or an Unconnected Message.

5.) New Module: P3-SCM (Serial Control Module) - The P3-SCM is a serial communications module capable of Modbus,
ASCII, and Custom Communication Protocols and able to power the C-More Micro through RS-232 (Port 1 Only).
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6.) Full Duplex is now supported on the RS 232 port and will now have the option of Half Duplex or Full Duplex when in
ASCII/ Custom Protocol mode. Full Duplex allows the serial port to transmit and receive simultaneously.

7.) Binary only for USB project load allows an OEM to download a file from USB pen drive without the .adpro file. This
will keep unwanted users the ability to connect with the GUI and view ladder code. In addition, they will not be able to
transfer from the PAC to pen drive thus protecting OEM source code.

8.) Data View graphing updated to allow options for line fill, line smoothing, and new tool tip to show data from a
specific data point.

9.) Tag Export & Project Save creates two separate files "name_extended.csv" & "name_basic.csv":

Extended: Includes all fields used to edit/modify tags in the TagDB.

Basic: Minimal fields used to import tags into Cmore, KepOPC & Point of View.

10.) Ability to enter an existing or new tag name in ladder instead of an instruction abbreviation will pop up the
Instruction Shortcut window. You have the ability to choose from a list of instructions in the drop down of either
contacts or coils to quickly add a new tag without having to enter the instruction first.

Productivity Suite Release Notes

Version 1.9.2.0

May 14, 2014

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1. Updated USB driver files that install with software to fix issue with digital signing of USB driver files.

Note: If 1.9.1.0 was installed on a PC that had never had P3000 programming sw installed the usb driver will have to be
deleted and the new sw version installed to resolve any issues.

Instructions:

1. Connect the PAC to the computer.

2. Open Device Manager and locate the Driver.

3. Right click the driver and select Uninstall. Make sure to check “Delete the Driver Software for the device”

4. Install new software with the updated drivers.

6. Watch Device manager as the driver is installed. Once the driver is complete and broken symbol is removed all is good.

Productivity Suite Release Notes
Version 1.9.1.0
January 22, 2014

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1. SEQinstruction "SHOW" is no longer displayed as a button, and clicking "SHOW" does not bring up a popup
dialog.
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Productivity Suite Release Notes
Version 1.9.0.13
December 4, 2013

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1. If a task name was modified or changed the appropriate Call instruction(s) were not updated with this change causing
a compile error.

2. UPKS will not allow you to accept if string array is used in source.

. Clear Edit function not refreshing in Dataview until user clicks away from highlighted fields.

. Detection of 10.20 IP address assigned to the external Ethernet port in hardware configuration window.

. Adding instructions that have multiple inputs to subrungs overwrites instructions on subrungs beneath it.

. The 'View as' option is not working in Dataview when sorting is enabled.

. Grey out Node Address field for serial ports configured as Ascii/Custom Protocol.

8. Run time transfer should not be available when opening a project that had dimension or type changes in array tags, or
length change in string tags.

9. Tab remains in PID tuning window after PID instruction is deleted.

10. When opening a project the tag database tags could become corrupted causing tags to be removed from both TagDB
and Dataview.

11. Newly added tags are not updating in Monitor View.

12. Importing the TagDB is adding duplicate quotation marks to the .csv file.

N o b~ Ww

Improvements:

1. Added ability to 'Go to'(CTRL+G) a specific task, rung, & column in a project.

2. MST bits now have default comments in the TagDB.

3. Removed 'Upload current RS232 & RS485' settings from Tools> Options> Project transfer. This option was never used
by the GUIL.

4. New free Apple iOS application available from iTunes store called 'PACDATA', PAC Data Remote Monitor App allows
the user to connect to remote PAC systems from a Wi-Fi, or cellular network connection. The Remote user can monitor
the local PAC system and user tags configured for remote access inside the tag database of the PAC.

5. Can now Add & Remove rows from a Data View window.

Note: GUI 1.9.0.x or higher has new imposed hardware limits: Max
Number of RS or RX groups 16
Number of EX supported with CPU/RS/RX 4
Number of RS or RX groups that can be set as 'LOCAL' (NDR) 4
Number of intelligent modules in Base 11
Number of intelligent modules in Group 11
Number of intelligent modules in system 22
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Number of GS eDRV modules on internal network 32
Number of MODbus TCP client connections (P3000 master) 64
Number of MODbus TCP server connections (P3000 slave) 32

Productivity Suite Release Notes
Version 1.8.2.1
June 6, 2013

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1) Fixed issue that would lock CPU when trying to download a project created with 1.8.0.x software to a CPU that had
firmware version earlier than 1.1.12.14. (1.1.11.28 or earlier)

2) GUI freezes when a hardware "Read Configuration" is done and the configuration in project does not match the
physical configuration of the bases.

Productivity Suite Release Notes
Version 1.8.0.19
May 15, 2013

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1. Viewing text in Dataview then changing string size in TagDB, would not display correct size after download.

2. Instructions with table’s text are black when disabled, should be grey.

3. Large projects could take long period during transfer or save of project file if large arrays were used in Dataview.

4. User set up P3-CPU with "illegal IP" address will cause CPU Ethernet port hard to recover. Valid IP addresses are from
1.0.0.1 to 223.255.255.254, excluding the loop back addresses 127.x.x.x.

5. Creating a system report with no project open in the GUI causes the GUI to lock up.

6. CPO instruction allows data specified to exceed 128 bytes.

7. Index out of range in array tags assigned in ladder breaks GUI.

8. Possible for integer tag to have Boolean edit value in Dataview.

9. Import Tags: Unable to import System Tags & MST bits with assigned Modbus Addresses.

10. Mouse scrolling does not work in Dataview when scrolling through elements of an array.

11. STA instruction reporting "Cannot Compile - Tag missing in instruction".

12. Software allows you to change the RS 232 port back to Modbus in hardware configuration when an ASCII instruction
is being used in a project.

13. NC contact while used with multidimensional array with a tag as an array index will not work correctly.

14. Modifying the number of characters in a string in the database does not change the amount of characters you are
allowed to enter into Dataview edit field if already being viewed in Dataview window.
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Improvements:

. Sorting of Dataview columns to allow ascending, descending or off.

. New Viewmarq instruction for easy set up and use to communicate to the Viewmarq panels.

. Improved Cross reference window with tag, task and filter options.

. Value cursor and hover for value added to Dataview graphing window.

. Mouse wheel scrolls ladder editor horizontally with shift key down and zooms in/out with control key down.

. Mouse over added for icons that let user know the edited ladder has not been saved, downloaded or both.

. Redesigned Hardware configuration window with improved graphics and ability to see hot swapped modules.
. Cross reference search can be selected as print option.

. P3000 programming software now supports Windows 8 OS.
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Productivity Suite Release Notes
Version 1.7.1.x
January 9, 2013

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1. Reading a project from the PAC that was created with a software version older than 1.7.0.18, then do a run time
transfer back to the PAC, you will get a critical error "Exxxx Prj Loader ScLibE", causing the PAC to go into stop mode.

Productivity Suite Release Notes
Version 1.7.0.18
December 5, 2012

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with
previous versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1. Possible 'spinner' on LCD of P3-550 using an intelligent module with analog module.

2. Creating a tag name over the 32 character limit causes tags to be removed from ladder contacts.

3. Find/Replace may not find tags with an instruction with empty (optional) tag properties.

4. Changing a GSW instruction from a GS1/GS2 to a GS3 causes the ladder for that task to disappear.

5. A saved Bit Histogram configuration without the "By Boolean Tag" assigned, this causes the inability to do a Module
Move operation in hardware configuration.

6. If 'Task Comment' is enabled and a 'Rung' is highlighted, the wrong rung is selected.

7. Error message added if trying to use a String array element in an MWX instruction.

8. Error message added when maximum of 4096 rungs is exceeded in a single task.

9. OUT coil using 'use block fills on contact' option checked can be wide depending on column width.

Features added:
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1. Option to 'append' tags to an already existing Dataview window.

2. Create System report that adds project(optional), connection, h/w configuration, sw & fw versions, and system info in
a simple one click .zip file.

3. New 'First Scan Interval [x100=usec]' system tag that holds the value of the First Scan Time.

. Added selectable timeout for web server in Hardware Configuration.

. Two new system tags 'Portable Memory Device Ready' & 'Portable Memory Device Eject'.

. New Remote Slave MST bit '‘Module Ready' that indicates good communication to the P3-550.

. Option to select P3-550 or P3-530 and go to hardware configuration window when starting a new project.

. Can now display 'lcons with Descriptions' with drop down arrow for tool bar icons.

. Option to select the number of recent project to remember that will be located under the File tab.

10. Under Options > Ladder tab, the ability to set Font, Font size, & color for all comments, tag name, system id, and
output text.

11. Selectable 'Optimize Rung Lengths' that automatically remove white spaces above 11 columns.

12. Ability to wrap & align tag names on contacts and coils.

13. Task properties the ability to set background & wire colors for individual tasks.

14. Support for new P-530 & P3-RX modules.

15. Ability to wrap tag names, scaling, set font size individually for all text. In addition options are now saved on Print,
can be manually reset.

16. Easier to use Firmware upgrade window with the ability to directly connect to an available PAC from this window.
17. Support for SRAM retentive memory increased to 492K on Rev D or higher P3-550 & all P3-530.

18. Global GUI settings for 'Editor Display Options' under Tools>Options>Ladder tab that will applied to all tasks in the
project.

19. Option to 'Warn before deleting a tag that is known to be in use' under Tools>Options>TagDB tab.
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Productivity Suite Release Notes
Version 1.6.2.4
November 27, 2012

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bugs Fixed:

1.) Outputs intermittently stay ON in Remote Slave units during a stop mode transfer. (Only applies to software version
1.6.1.6 & 1.6.0.19)

Note: If using a version older than 1.6, upgrade of software is not required.
Productivity Suite Release Notes

Version 1.6.1.6

July 25, 2012

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with
previous versions may alter the project and its functionality. Making backup copies of projects is
recommended.

Bugs Fixed:
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Copy & Paste between projects can create multiple tags with the same Modbus address.
Dataview icon on the Monitor toolbar does not bring up Dataview Window.
Find/Replace fails to provide results for array tags when an index is provided. (1D and/or 2D)
FILl instruction in ladder, using Print Preview has rendering problems.
Copy-Past of an instruction using Bit-of-Word between GUIs does not create a new tag.
Firmware upgrade Report text indicates wrong slot number for HSO module.
Find/Replace fails to replace array elements with a new basic tag of the same type (1d and/or 2D)
Upload current retentive values and copy to initial values option not working.
Allow individual array tags to remain in Dataview on project upgrade from versions 1.4.1.1 or older.
. Software locks up when transferring project with maximum monitor sessions.
. Software fails to retrieve firmware info from the firmware file if not connected to the PAC.
. Project containing an HSI module can still be downloaded to the PAC with older firmware.
. When using 9 or more LCD instructions an error “LCD name not found” is generated.
. Cannot enter and create a Bit-of-Word tag from any instruction that allows Bit-of-Word.
. Print settings do not retain when moving between print & preview selections.
. If arung has 5 or more contacts and uses Bit-of-Word, the logic doesn’t work correctly.
. TagDB rename using any existing references in instructions that use Bit-of-Word will not follow the name
change.
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Productivity Suite Release Notes
Version 1.6.0.19
April 25, 2012

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with
previous versions may alter the project and its functionality. Making backup copies of projects is
recommended.

Bugs Fixed:

1. Integer & Float tags will not print.

2. Opening project file from folder using right or double click opens software, but not the project.
3. SEQinstruction if ‘Limit Cycles’ is not enabled, done bit is not greyed out.

4. Use of array tags in PID tuning window causes error.

Features Added:

1. Support for new P3-HSO (High Speed Output), P3-HSI (High Speed Input) & P3-16TD3P (Fault Protected) modules
now supported.(Note: 1.6 S/W & 1.1.12.x F/W or later Required)

2. New High Speed Instructions:

SMOV (Simple Move)

VMOV (Velocity Move)

WHSO (Write High Speed Outputs)

SPOS (Set Position)

REG (Registration)

. HOME(Find Home)

High Speed Module Testing Utility used to quickly test motor, input & output wiring connections.

4. Web Server feature that allows viewing of read only system tags & the ability to open, save or delete files from USB
pen drive (if installed).

5. Bit of Word allowing a user to gain bit level access to Integer tag data types (includes 1D and 2D arrays).
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6. Updated toolbars using icons that allow convenient access to functions plus adds more workspace for ladder,
dataview & task management panels.
7. PID tuning window enhancements that allow viewing up to a maximum of 5 loops & data is kept updated if moving
between tabs.
8. Ability to now do a Partial search & replace tag names using Find/Replace tool.
9. Find New High Speed Instruction Filtered Option added to Instruction Search of the Find/Replace tool.
10. Firmware update tool updated with new features:
a. Be able to filter on selected modules from firmware file.
b. View firmware file off line & view firmware file version(s).
c. New individual firmware files in .adfw format.
d. New all-in-one firmware file that contains all current module firmware for easy upgrade.
e. 1.6 or higher software can use new .adfw or .zip file format.
Note: If upgrading from version 1.1.11.28 or older a second upgrade with the same 1.1.12.x firmware file is needed in
order to use the web server.
11. Leading zeros for integer’s option added for PKS (Pack String) Instruction.
12. Adjusting Font size in Print window now affects ladder & characters to help reduce number of overall printed pages.

Productivity Suite Release Notes
Version 1.5.1.2
November 29, 2011

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with
previous versions may alter the project and its functionality. Making backup copies of projects is
recommended.

This version of software is required if upgrading any P3-550 unit to firmware version 1.1.11.27.
Bugs Fixed:
1. GUI locks up while transferring projects with retentive string array enabled.
2. String Array length is reset to O while transferring projects with retentive to initial value option enabled.
3. 2D Array with only 1 element for the "Row" dimension displays incorrectly in Tagname Database.
Productivity Suite Release Notes

Version 1.5.0.21
November 16, 2011

IMPORTANT NOTICES: Using this version of Productivity Suite to save or download a project created with
previous versions may alter the project and its functionality. Making backup copies of projects is
recommended.

This version of software is required if upgrading any P3-550 unit to firmware version 1.1.11.26.
Bugs Fixed:

1. After installing Productivity Suite software sometimes would come up in Demo Mode.
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2. Several instructions will not fully paste into a new project. They will paste, but not all their tags will be added to the
tag database.

3. P3-08THM MST tag names can be deleted in hardware configuration window.

4. Copy and pasting a task would cause duplicate task numbers.

5. Constant Strings have the wrong sizes when compiled using LCD instruction.

6. RXand TX: remote project tags are lost when saving the projects.

7. Rung Comments can be lost during normal edit operations.

8. Copying and pasting a rung with blank sub rung re-arranges rungs incorrectly after compiling.

9. After changing a tag from 32 bit to 16bit the now unused Modbus address is not freed.

10. When transferring a Project from USB Drive, duplicate SystemIDs can be created.

11. No word wrapping for Wire Label or Comment fields.

12. Monitor mode causes software to become sluggish.

13. Error Message when creating more than 1000 tags was improved to indicate a stop mode transfer is required.

14. Issue when using Tag Indexed Array Element in the Math instruction would cause wrong result.

Features Added:

1. Improvements to PRINT function to include:
a. Wrap rungs
b. Individual font setup for all comments
c. Print selectable task & Dataview windows
d. Additional tag DB print selections
2. Off delay function added to STMR instruction.
New Dataview tab added to Options to allow new features
4. Improvements to Dataview to include:
a. Live trend graphing of tags
b. Block fills on Discretes
c. Enter an entire array into Dataview
The ability to Monitor values to a Dataview window from any instruction or from a ladder rung(s).
P3-USER-M is now installed with the software & available from windows menu.
New integer & string system tags for firmware major & minor versions.
Added new options for PID bias freeze of either on or use back calculation.
Improved software installer that allows the installation of multiple instances of the Productivity Suite software.
10. Removed P3-550 from hardware configuration list of hardware components & removed the ability to delete the P3-
550 from the base.
11. New Comment & Instruction search feature added to the Find/Replace function.

12. Added the ability to send/ receive string tags with the MRX, MWX, RX & WX instructions.

13. Added new port ready MST bits to both P3-550 & P3-RS communication ports to indicate module ports are ready
after a hot swap.

14. New P3-RS I/0 update rate to allow a user to set the P3-550 to scan remote I/O every scan or custom settings of
number of scans or a set time period.

15. Mouse Scroll sensitivity is page by page, not rung by rung.

16. Allow reordering of Tabs in Dataview.

w
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Productivity Suite Release Notes
Version 1.4.1.1
Jan 31, 2011
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IMPORTANT NOTICE: Using this version of Productivity Suite to save or download a project created with previous
versions may alter the project and its functionality. Making backup copies of projects is recommended.

Bug Fixed:
1. Opening a project with Productivity Suite version 1.4.0.29 would remove the tags from the project's data logging
configuration. If the project were sent to a PAC, no data would be logged.

Productivity Suite Release Notes
Version 1.4.0.29
Dec 09, 2010

Bugs Fixed:

1. Histogram configurations lost if a runtime project transfer performed. ‘Send Configuration to PAC' would need to be
repeated to restore histogram function.

2. Array Statistics (STA) instruction overflow bit would not reset when error condition was removed. Overflow bit would
clear upon disabling the instruction instead.

3. Improvement to printing layout of tag database.

4. Toggle Coil (TGC) instruction input was missing the edge-driven indicator, an upward facing arrow.

5. It was possible to corrupt the tag database with multiple entries of a single tag name, each having a different system
ID. The issues that allowed the corruption to occur have been fixed. The integrity of the tag database is now regularly
checked during editing and each time the project is compiled.

6. Data type of an array could not be changed once created. Attempting to change it would merely increment the
system ID or freeze up the tag database.

7. Network Read (RX) and Network Write (WX) ‘Refresh' button would not properly update the tags between the
projects.

8. Functions assigned some shortcut keys are corrected.

a. CTRL-F9 download project from PAC

b. ALT-F opens File menu

c. ALT-S opens Setup menu

d. ALT-P opens PAC menu

e. ALT-T opens Tools menu

9. Some Ethernet situations between the programming PC and PAC were not handled properly, infrequently causing a
project transfer failure.

10. The task names of multiple CALL (CALL) instructions were case-sensitive. If the case of the specified tasks did not
match the character case of the task name exactly, the calls would not execute.

11. Array Statistics (STA) will now only allow Sum operation when the array is Boolean. Other mathematic functions are
not allowed.

12. Using Custom Protocol Input (CPI) or Custom Protocol Out (CPO) instruction in a called task would result in a project
that would halt when that task was called.

13. Dialog concerning tuning constants was misleading. Also, the project status (out of date vs. up to date) was not
properly updated after changes to the tuning options.

14. Project Backup Directory could not be changed.

15. A tag could be incorrectly marked as In Use even if removed from all ladder.

16. Or Out (Or) instruction not working properly with Debug Single Step.

17. DataWorx (DWX) instruction that employed a string tag for the Where field and the MAP field list was empty would
not compile after reopening a project.

18. A project with more than 64 GS Drives Read (GSR) 64 GS Drives Write (GSW) instructions could cause a CPU fault on
transfer, or not operate properly if a transfer was successful.
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19. Copy Data (CPD) instruction would stop copying tags if one tag were erroneous (array index out of range). It will now
copy all data of all valid tags even if an invalid tag is encountered.

20. Normally Closed (NC) contact using an array tag with a variable index and a branch would fail compile.

21. GS Drives Read (GSR) instruction could apply values to the wrong tags (P2.00 - P2.10) depending on which drive
model is selected and which of these tags were in use.

22. It was possible for actions in Hardware Config to cause an I/O module to be missing a tag in the tag database. The
cause of this issue has been fixed. If this problem is found in an existing project, drop the same module on top of the one
with the missing tag. This will regenerate the tags for it in the tag database.

23. Using Unpack String (UPKS) instruction with a Destination tag of data type ‘Integer, 8 Bit Unsigned' would interpret
the characters as Hex instead of Decimal values. The instruction should translate as Decimal regardless of the
destination data type.

24. If a contact were shorted (wire drawn around a contact, as for troubleshooting) the values displayed in monitor
mode on that rung would be misplaced. The rung would operate as expected though.

25. Having five or more PID loops in a project would cause loops to not execute.

Features Added:

1. Added features to make connections to a PAC over the internet more reliable and more manageable:

a. Added selectable UDP Port Number to the User Defined Connections settings. Connectivity to multiple PACs behind a
firewall requires unique UDP Port Numbers.

b. Added adjustable timeout (up to 30 seconds) for the PAC connection attempt. The setting is located under
Tools/Options/Connection.

c. Software connection attempt to User-Defined connections will now make two retries. A connection countdown timer
was added to the PAC Connections dialog to show the progress.

d. User-Defined PAC connections are now automatically saved and can be imported and exported for moving them
between PCs.

e. Messaging between a PAC and Productivity Suite over Ethernet has been made more tolerant of messages being out
of order, lost, or delayed.

2. CTRL-A selects all ladder in a task

3. Adding a contact in ladder will now advance the cursor to the right, instead of remaining on the new contact.

4. The cursor location will now jump to column 11 if any coil is placed somewhere other than the end of the rung.
Previously, a warning would appear stating the location was invalid for a coil.

5. Added management rules and tools for in-use tags of modules being swapped or deleted in the hardware
configuration.

6. The hardware configuration right click menu for the P3-550 has a new option: Enable All Hot Swap. It will mark all PAC
I/O Hot Swap Enabled. It is intended for code troubleshooting in the absence of a complete hardware setup.

7. Added Standard Deviation option to Data Statistics (DATA) instruction.

8. Added option to make the inputs of several instructions level driven that were previously edge driven only. This can
simplify their use in run when called tasks.

a. Inc/Dec (INC)

b. Toggle Coil (TGC)

c. Shift Rotate Array (SRA)

d. Shift Rotate Bits (SFR)

e. Counter (CNT)

f. Simple Counter (SCNT)

g. FIFO/LIFO (FILI)

9. The Find tool becomes Find/Replace with an expanded search area, improved display of results and selective
replacement of tags.

10. PID (PID) minimum sample rate goes from 50ms to Oms. When set to Oms (or any value below the current scan
time), the PID loop calculates on every scan.
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11. Task Comments can be displayed at the top of ladder.

12. All system tags of new projects now have standard comments associated with them by default. These comments will
not be added to existing projects to avoid overwriting user-entered comments.

13. Added ‘Copy Binary’ option to Copy (CPY) instruction. This option will copy the binary pattern from one tag to
another instead of copying the value.

14. Windows 64-bit operating systems have USB port support for programming.

15. Added validation for the project version. Upon opening a project, Productivity Suite will determine which version of

Productivity Suite was used to generate the project. If a project is being pulled forward to a new version of Productivity
Suite, the user is prompted to make a backup copy. Pulling projects backwards is not allowed and the user would be
prompted to obtain the appropriate version of software to continue.

Productivity Suite Release Notes
Version 1.3.0.13.
Mar 31, 2010

Bugs Fixed:

1. Ladder with an OR, two ANDs and another OR could execute as all ORs.

2. Logical Word (LOGW) instruction allowed float and BCD inputs.

3. The space preceding ( in a constant string would be removed from the string.

4. Disabled instructions (STA, CPA, FLA, SRA, ALM, LALM, LIM, CMPV, FIB) would write to Boolean outputs.

5. Increasing the size of an existing array could cause some elements of two arrays to be assigned same memory
locations.

6. ASCIl Out (AOUT) instruction enable leg not labeled as edge-trigger.

7. Custom Protocol Out (CPO) instruction enable leg not labeled as edge-trigger.

8. Clear Serial Port Buffer (ACLR) instruction enable leg not labeled as edge-trigger.

9. Exported CSV does not include Initial Values for String Array.

10. Cannot embed empty parenthesis in a string literal.

11. Array tags IN USE indication not always correct.

12. Software not enforcing the limit of 64 forceable tags maximum.

13. Absolute encoder (ABSE) instruction not asserting offset to counts in Gray Code modes.

14. PID bias freeze not working properly.

15. CPD instruction could circumvent force tag if single tag was changed successively in one instruction.

16. Average (AVG) instruction time units were labeled and documented as milliseconds but executed as seconds.
Execution changing to be milliseconds.

17. Average (AVG) instruction output response rate potentially altered by fast scan time or data types assigned.
18. Modbus Write (MWX) or Network Write (WX) instructions SKIP EXECUTION IF BUFFER IS GREATER THAN XX% FULL
not functional on P3-RS serial port.

Features Added:

1. Copy/paste of a task now supported.

2. On project transfer, copy current values to initial values for retentive tags.
3. Red forced tag indicator in Data View.

Part 4: Technical Support Procedures

If you need technical assistance, you may find the information you need on our web site at
www.automationdirect.com/support. If you prefer, you can send us your inquiry at
http://support.automationdirect.com/techinquiry.html.Or you may call AutomationDirect at 1-770-844-4200 -- our
technical support team is available to answer your questions weekdays from 9 AM - 6 PM EST. Or you can fax the
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information to us at 1-770-886-3199 any time of day. Please provide the Version information when requesting technical
support. You'll find it under the Help > About.

Part 5: Help File Changes

We request that you contact us with any corrections, enhancements, changes that you would like to see in the
documentation please send us an inquiry at p3000feedback@automationdirect.com or select the feedback topic in the
software help file, Please always check the On-Line Help files and our web site at
http://www.aboutplcs.com/P3000/software/help/P3000.htm for updated and new information.

Part 6: Uninstalling Productivity Suite Programming Software

Before Starting: Data Backup
If you have saved projects that you feel are important to you, then you will need to make a backup of these files. Please
backup your project files before uninstalling.

Before Starting: Remove USB Cable
If the P3-550 is connected to the PC USB port, then the USB driver will be active. Please Remove USB Cable between PC
and P3-550 before Uninstalling.

Part 7: Contact Technical Support

Telephone: 1-770-844-4200
Our technical support hours are from 9am to 6pm Eastern Standard Time Monday through Friday.

FAX: 1-770-886-3199

Technical Support Inquiry
http://support.automationdirect.com/techinquiry.html

Discussion Forum: AutomationDirect Customer Forum
http://foruml.automationdirect.com/
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